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1 General Information

1.1 About these instructions

The following configuration guide describes the setup, functions, and use of the TBEN-LH-8IOL station. It
helps you to plan, design, and implement the system for its intended purpose.

Note*: Please read this manual carefully before using the system. This will prevent the risk of personal

injury or damage to property or equipment. Keep this manual safe during the service life of the system. If
the system is passed on, be sure to transfer this manual to the new owner as well.

1.2 Explanation of symbols used

1.2.1 Warnings

Action-related warnings are placed next to potentially dangerous work steps and are marked by graphic
symbols. Each warning is initiated by a warning sign and a signal word that expresses the gravity of the
danger. The warnings have absolutely to be observed:

DANGER!

DANGER indicates an immediately dangerous situation, with high risk, the death or severe injury,
if not avoided.

WARNING!

A WARNING indicates a potentially dangerous situation with medium risk, the death or severe
injury, if not avoided.

ATTENTION!

ATTENTION indicates a situation that may lead to property damage, if it is not avoid-ed.

H..

In NOTES you find tips, recommendations and important information. The notes facilitate work,
provide more information on specific actions and help to avoid overtime by not following the
correct procedure.

» CALLTO ACTION
This symbol identifies steps that the user has to perform.

= RESULTS OF ACTION
This symbol identifies relevant results of steps

Italic  Text in ltalic is associated with the function of the third party software or application
(E.g. Controller Organizer)
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1.3 Contents

The complementary documentation and files:

TBEN-LH-8IOL Data sheet
TBEN-L...-8I0L, I0-Link Master Module
IO-Link Devices Commissioning

TBEN-LH-8IOL_R2.7.EDS file

The Rockwell PLC demo:
B 1756-L72 controller v30

B 1756-EN2TR Ethernet Bridge
B Studio5000 Logic Designer V30

The Omron PLC demo:
B CJIM controller v2.0

B CJ1W-EIP21 EtherNet/IP communication adapter v1.01
B Network Configurator 3.21

1.4 Feedback about these instructions

We make every effort to ensure that these instructions are as informative and as clear as possible. If you
have any suggestions for improving the design or if some information is missing in the document, please
send your suggestions to techdoc@turck.com.

1.5 Technical support

For additional support, email inquiries to appsupport@turck.com, or call Application Support at 763-553-
7300, Monday-Friday 8AM-5PM CST.
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2 Getting Started

2.1 About this document

The configuration guide provides information about configuration of the TBEN-LH-8IOL including:
B Address switches
B |P address assignment

B Configuration options with Rockwell and Omron PLCs

ﬂ NOTE
The device data sheet and technical information is available for download at
www.turck.us.

2.2 Factory default IP address

The TBEN-LH-8IOL device is shipped with address switches set to 600 (PGM-DHCP). It is factory default
position of the rotary switches which is associated with the IP address:

IP Address: 192.168.0.254
Subnet mask: 255.255.252.0
Gateway: 0.0.0.0

The device has limited functionality in this state:
DHCP client is active and running; use any service to assign IP address

B Web server is active
B Some other services are active
B ARGEE PLC is running

The device responds to the PING command as follows:

@ Administrator: Command Prompt | =l X

C:\Users\bbegic>Ping 192.168.0.254

Pinging 192.168.0.254 with 32 bytes of data:

Reply from 192.168.0.254: bytes=32 time=1ms TTL=128
Reply from 192.168.0.254: bytes=32 time=1ms TTL=128
Reply from 192.168.0.254: bytes=32 time=1ms TTL=128
Reply from 192.168.0.254: bytes=32 time=1ms TTL=128

Ping statistics for 192.168.0.254:

Packets: Sent = 4, Received = 4, Lost = 0 (0% loss),
Approximate round trip times in milli-seconds:

Minimum = 1ms, Maximum = 1ms, Average = 1ms

Figure 2.1 - Ping
The first step in the device configuration is to assign an operational IP address.

The device DHCP client is running and waiting for an IP address assignment. When IP address is
acquired, the DHCP becomes disabled.

7789 | F +1 763 553 0708 | www.turck.com




2.3 Address switches

The device has 3 rotary address switches. The position of the switches (Figure 2.2) determines mode of
operation of the device. The Table 2.1 provides a description of the device action when switches are set to
a specific position and the device is powered up.

000: 192.168.0.254
~ ¥ ~ ¥ -~ b 1 -254: static rotary
I = o o @ = w 300: BootP
L) & L & o 400: DHCP
gL &1 gL 500: PGM
600: PGM-DHCP
x 100 x10 x1 900: F_Reset

Figure 2.2 — Rotary switches

ﬂ NOTE

Protective cover opened - Protection class IP65/IP67/IP69K not warranted
» Screw the protective cover over the rotary coding-switches firmly
» Check if seal of the protective cover is correctly placed

Switch position Mode Description
000 Restore IP address is restored to 192.168.0.254
Static rotary .

001,...,254 mode Sets the last octet of IP address in range [1...254].
300 BOOTP BOOTP client is active and requesting an IP address
400 DHCP DHCP client is active and requesting an IP address
500 PGM Device comes up with the last IP address saved in

EEPROM. IP address is programmable.
DHCP client is active and requesting an IP address.
600 PGM-DHCP When IP address is acquired, the device transitions to
PGM mode.
900 Factory Reset Device is reset to the factory default setup.

Table 2.1: Address Modes

2.3.1 Static rotary mode

Sets the last octet of the IP address in the range [xxx =1 ,..., 254] e.g. 192.168.0.xxx, 10.10.10.xxx.

2.3.2 BOOTP mode (300) and DHCP mode (400)

The device BOOTP or DHCP client is active, requesting an IP address assignment.
From any switch position:

Turn OFF device power and set switches to 300 or 400

Start BOOTP / DHCP server

Turn ON device power and assign IP address

Wait for the acknowledgement from the server

Set rotary switches to either the last octet of the IP address or to 500 (PGM)
Cycle power

YVVVYVYYVY
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2.3.3 PGM mode (500)

The last known IP address, subnet mask and gateway address are saved in the EEPROM when rotary
switches are set to 500. The IP address is programmable and may be programmed using TURCK Service
Tool or Web server. The procedure:

» Assign an IP address using either static rotary mode, or BOOTP/DHCP server

» When IP address is acquired, change rotary switches position to 500

» Cycle the power of the device

2.3.4 PGM-DHCP mode (600)

When out-of-box device is powered for the first time, while switches are set to 600, the device DHCP
client is active and waiting for an IP address assignment. Use any DHCP server to assign the IP address.
When IP address is acquired, the device disables its DHCP. The device saves permanently assigned IP
address and transitions to the PGM mode.

2.3.5 Factory Reset mode (900)

The factory reset mode resets the device back to the factory default setup and deletes all custom data in
the device’s internal flash. The procedure:

» Set address switches to 900

» Power-up device and wait 10sec

»  Set switches to either static rotary mode or 300/400/500/600

» Cycle power

2.3.6 Restore IP Address (000)

Set rotary switches to 000 to restore IP address to 192.168.0.254. The device preserves custom
data/setup while restoring IP address.

From any switch position:

Set the address switches to the position 000

Power-up device and wait 10sec

Set switches to either static rotary mode or 300/400/500/600

Cycle power

Depending on the position of the rotary switches, the device comes up as previously described.

VVYVYV
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2.4 TURCK Service Tool (TST)

The TURCK Service Tool can be downloaded from the TURCK Web site at:

» Enter “TURCK Service Tool” in the search field
» Download and install the tool

Y| S=Rac >
.f = Search - Turck USA x
&« C 1t | @ www.turck.us/en/search.php?q_simple=TURCK+S @ ¥ 20 : |
2= Apps E Suggested Sites Imported FromIE & Google Health st MSNBC Merriam-Webster's »

TURCK.COM '“ncx
v M e n U ‘ TURCK Service too Q ‘

Figure 2.3 — TURCK Web page

The tool has a set of action buttons in the tool bar:

—
= Turck Service Toal, Vers. 3.1& SHIEH X
Your Global Automation Partner TTUOUrRRCiK
Q & . M . eNn . b 4
Search... (F5) | Change (F2) Wink (F3) Actions (F4) Clipboard Language Expert view OFF | Close
No 7 MAC address N.. IP address Netm Gatew.. Mode Device Version Adapter Protocol
- ‘I 00:07:46:52:56.07 192168.0.254 0000 0000 PGM_DHCP.A TBEN-LH-8IOL 3180 192168.047. 192168.148 DCP.Turck |

Found 1 Device.

Figure 2.4 — Service Tool

The tool has following features:

B Scanning for existing devices (F5). All modules are found through use of the protocols DCP
(PROFINET Standard) and IBTP (TURCK Service Protocol). With the IBTP protocol extended
information such as FW version and operating mode improved scanning are read out of
TURCK devices and displayed.

Setting an IP address (F2)

Locate device using Wink function (F3)

Actions menu that resets the device to the factory default or reset network (F4)
Supports the configuration of PROFINET modules, assigning the PROFINET name
Clipboard used for Copy: all, IP address or MAC address

Expert view, when enabled, provides additional functions like DHCP Server, ARGEE and
BEEP features by TURCK multiprotocol device

DHCP server
ARGEE status
BEEP status
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Frequently used functions of the tool are:
Search (F5)

B Change (F2)
B DHCP (F6)
W Action (F4)

2.4.1 Search (F5)

The Search function is used to identify TURCK multiprotocol device on the continuous physical network
segment including layer 2 of the OSI model switches. The IP address 192.168.0.254 appears when the
device is in the PGM-DHCP mode and DHCP client is active. The IP address transitions to 0.0.0.0 when
DCHP server is started. The device mode is provided (position of the rotary switches), composite firmware
revision, ARGEE loaded program is running, and BEEP status of the device if enabled.

"= Turck Service Tool, Vers. 3.1.0 Eh

Your Global Automation Partner UUONRCEK

FZ N > S U I - R o 3 EIP H .= | %

Search... (F5) | Change (F2) Wink (F3) Actions (F4) Clipboard Language Expert view ON | Start DHCP (F6) Configuration (F7) ARGEE (F8)  BEEP (F9) Close

No < MAC address N.. IP address Netmask Gatew.. Mode Device Version Adapter ARGEE &
=3 000746:82:56:07 1921680254 2552552520 0000 PGM DHCP A  TBEN-LH-8IOL 3180 192168047 running HundaiTEENiMap,LVLDJGNO\‘E‘
=2 00:07:46:0D:77:81 136.129.1.231 2552552550 0.0.00 PGM_DHCP TBEN-S2-2RFID4DXP 3510 192168.047.. supported N

" 1 00:07:46:07:37:88 192.168.1.100 2552652650 0.000 PGM DHCP TBEN-52-4I0L 3250 192.168.047.. suuuonled T

4 il b

Found 3 Devices.

Figure 2.5 — Search function
2.4.2 DHCP (F6)

The device IP address may be assigned using the DHCP server provided by the tool.
The procedure:

Search (F5) to discover device with address 192.168.0.254

Highlight that device

Start DHCP (F6)

Select network adapter in the DHCP server settings page and click Start DHCP

YV VYV YV

= Turck Service Tool, Vers. 3.

= DHCP server settings C="1=

Your Global Aut: How to use the DHCP feature
- Select network adapter.

- Set Lease Time.

- Start DHCP feature.

- Wait for devices to be found.

P | g | A
Search... (F5) | Change (F Qt DHCP (F6) Confit
No = MAC addres! ELCESEnas Version Ac

=3  00.0746:82:56:07 Network adapter oL 3180 19

=2 00.0746:0D:77:81 Local Area Connection (IP =192.168.0.4 A RFID-4DXP 3510 19
=1 000746073788 oL 3250 19
Lease Time (s)

Set Lease Time to infinite.

«

Start DHCP ] [ Cancel

4 |
Found 3 Devices.

Figure 2.6 — Initialize DHCP server
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»  Wait until DHCP server locates the device ( IP transitions to 0.0.0.0)

© _ [0 . EN o«

Search... (F5) = Change (F2) Wink (F3) Actions (F4) Clipboard  Language Expert view ON | Stop DHCP (F6) Confi
No. MAC address Name IP address Netmask Gatew... Mode Device Version
PGM_DHCP | TBEN-LH-16DIP :

=2 :07:46:00: 1361291231 25562562550 0000 PGM_DHCP TBEN-SZ-2RFID-4DXP 3510
=3 00:0746:07:37:B8 1921681100 2552552550 0000 PGM_DHCP  TBEN-32-4I0L 3250

Wait for devices to be found via DHCP. Then select device and assign IP address with "Change (F2)".

Figure 2.7 — Device DHCP client active view

Highlight device

Click Change (F2)

Assign IP address

Click Stop DHCP (F6) button

YV VYV YV

IP configuration

ey

Change (F2) Wink (F3) Actions (F4) MAC address IP address

Search... (F5)
000746825607 19216801
No. T MAC address N.. IP address Netr | “
%3 00:07:46:82:56:07 0.000 a0
=2 00:0746:0D:77:81 1361291231 f Netmask Gateway F3510
=1 000746073788 1921681100 || 2552552520 0000 3250

Set IP configuration temporarily

Status messages:

il
Wait for devices to be found via DHCP. Then select de

Figure 2.8 — IP Configuration

After the IP address is assigned, the device responds with:

@ _ [0 . eNn . @ EIP =
Search.. (F3) | Change (F2) Wink (F3) Actions (F4) Clipboard  Language Expert view ON | Stop DHCP (F6) Configuration (F7) ARGEE (F8)  BEEP (F9) Ch
No. - MAC N.. IP add N k Gatew.. Mode Device Version Adapter ARGEE
.3 00:07:46:52:56:07 192.168.0.17 2552552520 0000 PGM_DHCP,A  TBEN-LH-8IOL 3180 192.168.047.. running Honda_TBEN_Map_1_Vi1_{
.2 00:07:46:0D:77:81 1361291231 2552552550 0000 PGM_DHCP TBEN-S2-2RFID-4DXP 3510 192.168.047.. supported
.1 00:07:46:07:37.B8 192.168.1.100 2552552550 0000 PGM_DHCP TBEN-S2-410L 3250 192168.047.. suppored

Figure 2.9 — IP address assigned
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2.4.3 Set IP address using Web server

The device Web server is a communication interface with the device and offers several setup options. Itis
necessary to login as an administrator to change device IP address.
The procedure:

» Enter current IP address of the device into a browser

» If you don’t know what is current IP address, use TURCK Service Tool to discover device

» Enter “password” into Login field to get administrator’s privilege.

Heaith [ mswec &

Enter current IP
address
"password”

TURCKCOM  For TURCK Support

TBEN-LH-8I0L

Mermam-Webster's -

Enter password

v @

TURCK USA - Capa & Google News  »

LOGIN

Station Information
1 Inf tion
S\aicn Bieguasice Station Information
Event Log
Bl S tialien Type TBEN-LH-8I0L
Links Identification Number 100002195
Firmware Revision V3180
I0-LINK PORT 1 Boolioader Revision Vi000
10-LINK PORT 2
EtharNet/IP™ Revision V2TA0

Figure 2.10 — Device Web server

» Open Network Configuration menu, enter new IP address and then Submit
» If your PC network adapter is set to the same subnet as the device’s subnet, you are going to
see the device which comes up with the new setup

TURCK.COM

TBEN-LH-810L

STATION
Station Information
Station Diagnostics
Event Log
Ethemet Statistics
Links
Station Configuration

BEEP Network Configuration
Change Admin Password

BASIC
I0-LINK PORT 1

IO-LINK PORT 2 >
IO-LINK PORT 3 »

I0-LINK PORT 4

I0-LINK PORT 5
IO-LINK PORT 6
IO-LINK PORT 7

For comments or questions, please email TURCK Support

Network Configuration

Network Settings
Ethemnet Port 1 setup
Etherne! Port 2 salup
IP Address

Netmask

Default Galeway

SNMP Public Community
SNMP Privale Community
MAC Address

LLOP MAC Address 1

LLDF MAC Addrass 2

13

Enter new IP
address

LOGOUT [ADMIN@192.168.0.47)

Autonegotiate v
Aulonegoliale v
“ 192.168.0.17
255.255.252.0
oooo
public
private
00:07 4682 56:07
00,07 46.82.56.08

0007 4682 56 08
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2.5 BOOTP/DHCP utility

The BOOTP/DHCP utility may be used while the device is in the PGM-DHCP mode on the first power-up.
When the IP address is assigned, the device DHCP client becomes disabled.
The procedure:

» Start Rockwell DHCP server
» Select network interface

Please select a network interface:

Description | IP Address |
ASTX AX88772 USB2.0 to Fast Ethernet Adapter #2 192.168.0.47
Bluetooth Device (Personal Area Metwork) Unknown
Intel(R) Ethernet Connection 1219-V Unknown
VirtualBox Host-Only Ethernet Adapter 192.168.56.1

Figure 2.12 — BOOTP / DHCP tool

» At Tools menu, click at Network Settings
?j BootP DHCP EtherNet/IP Commissioning Tool g X

File [Tools| Help
Network Settings Claar History
— Add Relation
Clear Discovery History ress ‘ Hostname |
Delete Relation

Enable BOOTP/DHCP

Disable BOOTP/DHCP

Reset Module's Network Settings to Factory Defaults
Properties

Entered Relations

Figure 2.13 — Network Settings menu

» Enter Mask and Gateway addresses in the Network Settings dialog

Metwork Settings - — u

— Defaults
Adapter ASIKAXEE77E LUSE2.0 to Fast Ethernet Adapter #2

Server IP address: |192-153.U.4?

SubnetMask: | 256 . 255 . 252 . O

Gateway: | 192 . 168 . 0 . 1

Frimary DMNS: |

Secondary DMNS: |

Domain Name: I

Feset Defaults | oK I Cancel |

Figure 2.14 — Network Settings view
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» Enter new IP address in the New Entry dialog

BootP DHCP EtherNet/IP Commissioning Too

File Tools Help

Add Relation Discavery Histary Clear Histary |

Ethernet Address (MAC]\ Type | [hr:min:sec]| # | IP Address | Hostname

00:07:46:02:8F:20 New Entry .- L

Senver P Address: |192.wea.n.4?

Clignt Address (MAC): IDD 07:46:02:8F-20

ClientIP Aderess: | 192 . 188 . 0 17

Hostname: I
Ethernet Address (K| I

Description:

oK I Cancel |

Figure 2.15 — IP address setup

»  Wait for confirmation — assigned IP address appears in the IP Address column

File Tools Help

Add Relation | Discavery Histary Clear Histony

Ethernet Address (MAC)‘ Type | (hr:min:sec]‘ # | IP Address ‘ Hostname
00:07:46:02:8F:20 DHCP 10:26:51 102 192.168.0.17
< 1 | »

Entered Relations

Ethernet Address (MAC) | Type | IP Address | Hostnamel Description |
00:07:46:02:8F:20 DHCP 192.168.0.17

Figure 2.16 — IP address assignment complete
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3 TBEN-LH-8IOL Controls Reference

3.1 Device Overview

The summary of the device installation guidance, connector’s assignment, power distribution and grounding
requirements are as follows.

3.1.1 Dimensions and connector assignment

! 2305

Figure 3.1 — Connector assignment

3.1.2 Power connector pin assignment

Pin assignment

X1=voltage IN

- < X2 = voltage OUT for supplying the next node

1RD =24VDC V2
1 3 2GN =24vDC V1 3/6 o] ) .
2'®_%/4 3WH=GND V1  4\@_9/2 V1 = supply voltage 1 (incl. supply of electronics)

4BK =GND V2 V2 = supply voltage 2
X1 X2

Figure 3.2 — X1 and X2 connector pinout

3.1.3 10 connector pin assignment

p 1 =Vaux'] {Ul} 2 1 ="||I"a|_|,.|:l “l”}

5 2=DXP (V1) 5 2 =Vaux (V2)
1lopol3 3=GND (V1) 13 3=GND (V1)

(s] 4=0C/0Q (V1) o 4 =0 M)
5 4 S5=nc L 4 S=0GND (V)
C0..C3 C4..C7

Figure 3.3 — C0...C7 connector pinout
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3.1.4 Power supply

Power supply

Supply voltages 24V DC from operating voltage
Permissible range 18...30VDC
10-Link:

20,4 ... 288V DC (acc. to 10-Link standard)

Total current max. 9 A per module

Operating current < 120 mA

Sensor/actuator supply Ve Supply from V1
short-circuit proof, max. 4 A for C0 & C4,
short-circuit proof, 2 A per group C1-C4,C5-C8

Sensor/actuator supply Vay (Class B-supply from V2
short-circuit proof, 2 A per connector C0-C7
Potential isolation =500V (V2 to Ethernet and V1)
|0-Link
Mumber of ports 8
10-Link specification V1.0, V1.1 according to [EC 61 61131-9
10-Link port type Class Aat COto C3
ClassBatC3to C7
Frame type Supports all specified frame types
Process data for |O-Link devices
Input data max. 32 Byte per channel
Output data max. 32 Byte per channel
Transmission rate 4,8 kbps (COM 1)
38,4 kbps (COM 2)

2304 kbps (COM 3)

Transmission cable Length: max. 20 m
standard cables,
3- or 4-wire ({depending on the application),
unshielded

ATTENTION!

Wrong supply of 10-Link devices
Damage to the electronics
» The IO-Link devices must only be supplied with the voltage provided at the supply terminals of

the TBEN

ATTENTION!

Connection of Class A devices to Class B ports
Loss of the galvanic isolation
> Only use Class A devices with signals on pin 1, pin 3 and pin 4 at Class B ports. The connection
of Class A devices with signals on pin 2 and pin 5 leads to the loss of the galvanic isolation
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3.1.5 LEDs
LED6 LEDS LED4 LED3 LED2 LEDM LEDO
ETH
BUS ERR LED15 LED14 LED13 LED12 LED11 LED10 LEDY LEDE PWR
Figure 3.4 — LED assignment
LED Color 5Status Meaning Remedy
PWR gree  off V1 missing or < 17V DC Check V1
: on V1 and V2 OK -
blinking V2 missing or < 14.5 VDC Check V2
ETHx gree on Link established, 100 Mbps
n blinking Ethernet Traffic, 100 Mbps
yel- on Link established, 10 Mbps
low blinking Ethernet Traffic, 10 Mbps
- off Mo Ethernet link. Check the Ethernst connection.
ERR gree  on Mo diagnostic message available
n
red on Diagnostic message pending
BUS gree  on Active connection to a master -
n blinking Device is ready for operation -
Red on IP address conflict orrestoremode  control IP addresses in the network
or timeout waiting for the device to be ready
for operation
blinking Blink-/wink-command active see also description of LED “right
to ERR"
red/ on Autonegotiation and/or waiting
gree for DHCP-/BootP-address assign-
n ment.

Figure 3.5 — Module LED behavior
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LED Color Status Meaning Remedy
10Lx Channel in 10-Link-mode
gree  off Mo 10-Link communication, diag- connect an 10-Link device
n nostics deactivated Farameterize the channel as DI if
necessary.
flashing |O-Link communication active, -
valid process data
Red on Mo l0-Link communication and/or  Possible causes:
module error, Sensor supply is below the admis-
invalid process data sible range,
[0-Link port is parameterized as
simple digital input,
Mo device connected to the mas-
ters,
Red flashing |O-Link communication active and Mo input data received from the
module error, invalid process data connected device (only valid for
devices with an
input data length = 0),
the connected device does not
respond on sending
output data (only valid for
devices with an output data
length of = 0).
connected device sends an error:
"process data invalid".
see also:
Start-up problems - frequent
failure causes, page 115
Channel in DI-mode
gree  off -
n
gree  an Input signal active
n
DXPx gree  off -
n
gree  on In-/ output signal active
n
Red on Short circuit at output of the
respective channel
right white  flashing Support for localizing a module if -
to the blink-/wink-command is acti-
ERR vated

Figure 3.6 — 10 LED behavior
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3.2 10 data map

3.2.1 General overview

The default data size of the TBEN-LH-8IOL is:
B 292 Byte Inputdata size, (146INT)

H 296 Byte Output data size, (148INT)

TWURCK
Honda TBEN-LH-8I0L Data Map Overview - 7_APR_2018
Data from RSL/Robot to TBEN Data from TBEN to RSL/Robot
Description RSLogix Index Fanuc Starting bit Description RSLogix Index Value Fanuc Starting bit
10L Channel Disable and COto C7 DXP Outputs 0 0 DXP and Cx Input Status 0 0
|0L COto C7 Mapping 1 16 Diagnostic and |0L Data Valid 1 16
VAux 1and VAux 2 Control 2 32 COI0L Port 1 Input Data Word 0 2 32
|10L 16 Data Word Enable 3 48 COI0L Port 1 Input Data Word 1 3 48
COI0L Port 1 Qutput Data Word 0 4 [ C1I0LPort 2 Input Data Word 0 4 64
CO010L Port 1 Output Data Word 1 5 30 C1I0LPort 2 Input Data Word 1 5 80
C110L Port 2 Output Data Word 0 6 96 C210L Port 3 Input Data Word 0 6 96
C110L Port 2 Output Data Word 1 i 112 C210LPort 3 Input Data Word 1 7 112
C210L Port 3 Output Data Word 0 8 128 C310L Port 4 Input Data Word 0 8 128
C210L Port 3 Qutput Data Word 1 9 144 C3 0L Port 4 Input Data Word 0 9 144
C310L Port 4 Output Data Word 0 10 160 C410L Port 5 Input Data Word 0 10 160
C310L Port 4 Qutput Data Word 1 11 176 C410LPort 5 Input Data Word 1 11 176
C410L Port 5 Output Data Word 0 12 192 C510L Port 6 Input Data Word 0 12 192
C410L Port 5 Output Data Word 1 13 208 C5 10L Port 6 Input Data Word 1 13 208
C510L Port 6 Output Data Word 0 14 224 C6 0L Port 7 Input Data Word 0 14 224
C5 0L Port 6 Output Data Word 1 15 240 C610L Port 7 Input Data Word 1 15 240
C610L Port 7 Output Data Word 0 16 256 C7 0L Port 8 Input Data Word 0 16 256
C610L Port 7 Output Data Word 1 17 272 C710L Port 8 Input Data Word 1 17 272
C710L Port 8 Qutput Data Word 0 18 288 CO 0L Port 1 Input Data Word 0- 16WD Enabled 18 288
C710L Port 8 Output Data Word 1 19 304 DrrrrIoorrroorInrrioirriorrrirroinod
CO 0L Port 1 Qutput Data Word 0- 16WD Enabled 20 320 COI0L Port 1 Input Data Word 15 - 16WD Enabled 33 528
COI0L Port 1 Qutput Data Word 15 - 16WD Enabled 35 560 C7 10L Port 8 Input Data Word 0- 16WD Enabled 130 2080
C710L Port & Output Data Word 0- 16WD Enabled 132 2112 C710L Port 8 Input Data Word 15 - 16WD Enabled 145 2320
C710L Port 8 Output Data Word 15 - 16WD Enabled 147 2352

Figure 3.7 — 10 data map overview

Minneapolis, MM 55441 | T +1 800 544

v.turck.com
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3.2.2 Input data map

®  |nput data map overview

Honda TBEN-LH-8IOL

Honda TBEN-LH-8IOL Input Data Overview - 7_APR_2018

Data from TBEN to RSL/Robot
Description

RSLogix Index Value Fanuc Starting bit

DXP and Cx Input Status 0 1]
Diagnostic and |0L Data Valid 1 16
COI0L Port 1 Input Data Word 0 2 32
COIOLPort 1Input Data Word 1 3 43
C1I0LPort 2 Input Data Word 0 4 64
C1I0L Port 2 Input Data Word 1 5 80
C2 10L Port 3 Input Data Word 0 6 96
C210LPort 3 Input Data Word 1 7 112
C3I0LPort 4 Input Data Word 0 8 128
C310LPort 4 Input Data Word 0 9 144
C410L Port 5 Input Data Word 0 10 160
C410L Port 5 Input Data Word 1 11 176
C5I10L Port 6 Input Data Word 0 12 192
C510L Port 6 Input Data Word 1 13 208
C6 0L Port 7 Input Data Word 0 14 224
C610L Port 7 Input Data Word 1 15 240
C710L Port 8 Input Data Word 0 16 256
C710L Port 8 Input Data Word 1 17 272
COI0L Port 1 Input Data Word 0- 16WD Enabled 18 288 B
COIOLPort 1 Input Data Word 15 - 16WD Enabled 33 528
130 2080
C710LPort 8 Input Data Word 15 - 16WD Enabled 145 2320

10Link Port Data Valid Indicators

TUNRCK

} DXP Input Bits and Disabled 10L Port 24V Input Bits

10Link data from TBIL Stationsor Stack Lights or
valve banks or other 1 or 2 word devices

Future proofing - RFID or otherunplanned devices

B [nput data map, word 0

Figure 3.8 — Input data map, overview

Honda TBEN-LH-8I0L

Honda TBEN-LH-8IOL Input Data Word 0 - 7_APR_2018

TUUNRCK

Data from TBEN to RSL/Robot Word 0.0t0 .15
Description RSLogix Index Value Fanuc Starting bit
DXP and Cx Input Status 0 0
CO DXP Input Active 0 0 } Setwhen CO DXP input (Pin 2} is 24V=0N M12 x 1 /0 Port
C1 DXP Input Active 1 1 : <
C2 DXP Input Active 2 2 : - ‘ - 5 1 =Vauel (V1)
€3 DXP Input Active 3 3 } Setwhen C3 DXP input (Pin 2) is 24V=0N 5 27D‘X“P-V1)
reserved 4 4 13 3=GND (V1)
o 4=C/Q (V1)
reserved 5 5 5" 4 5=nC
reserved 6 6
reserved 7 7 c0..C3
COPIN4DI 8 8 ’}— Setwhendisabled IOLPort1 (Pin4) is 24V=0N M12 x 1 I/O Port
C1PIN4 DI 9 9 :
C2 PIN4 DI 10 10
C3PINADI 1 1 = x:::; m:
C4 PIN4 DI 12 12 3=GND (V1)
C5 PIN4 DI 13 13 ‘5‘ - g\?[){w;’”
C6 PIN4 DI 14 14 :
C7 PIN4DI 15 15 F}— Setwhendisabled IOLPort8 (Pin 4) is 24V=0ON

Turck Inc. | 3000 Campus Drive, Minneapolis, MN 55441 | T +1

Figure 3.9 — Input data map, word 0
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Input data map, word 1

Data from TBEN to RSL/Robot

Word 1.0to.15

Description

RSLogix Index Value

Fanuc Starting bit

Diagnostic and I0L Data Valid 1 16
Diag 0 16 }— | Diagnostic Active
reserved 1 17
Vi 2 18 — Vloutofrange
V2 3 19 — V2outof range
FCE 4 20 — ForcingEnabled
reserved 5 21
reserved 6 22
reserved 7 23
COIO0L Port 1 Data Valid 8 24 SetwhenlOLPort 1 Data is Valid
C110L Port 2 Data Valid 9 25 ‘
C210L Port 3 Data Valid 10 26
C3I10L Port 4 Data Valid 11 27
C410L Port 5 Data Valid 12 28
C510L Port 6 Data Valid 13 29
C610L Port 7 Data Valid 14 30 B
C710L Port 8 Data Valid 15 31 H SetwhenlOLPort 8 Data is Valid

Turck Inc. | 3000 Campus Drive, Minneapolis, MN 55441 | T +1 800 544 7769 | F +1 763 553 0708 | www.turck.com

Figure 3.10 — Input data map, word 1
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3.2.3 Output data map overview

Honda TBEN-LH-8I0OL

Honda TBEN-LH-8I0L Output Data Overview - 7_APR_2018

Data from RSL/Robot to TBEN

TUURCK

10Link channel disable, 24V output control

Data Mapping for each 10Link Channel
Turn off VAuxland VAux2 power

Enable 16 Data Word |0Link data transfer

10Link data to TBIL Stations or Stack Lightsor
valve banks or other 1 or 2 word devices

Description RSLogix Index Fanuc Starting bit
10L Channel Disable and COto C7 DXP Outputs 0 0 __}-
10L CO to C7 Mapping 1 16 |-
VAux 1 and VAux 2 Control 2 32 f
10L 16 Data Word Enable 3 48 :]—
COI0L Port 1 Output Data Word 0 4 64

COIOL Port 1 Output Data Word 1 = 80

C1I0L Port 2 Qutput Data Word 0 6 96

C1I0L Port 2 Qutput Data Word 1 7 112

C2I0L Port 3 Output Data Word O 8 128

C2I0L Port 3 Output Data Word 1 9 144

C3 10L Port 4 Output Data Word 0 10 160

C3 10L Port 4 Output Data Word 1 11 176

C4 0L Port S Output Data Word 0 12 192

C410L Port 5 Output Data Word 1 13 208

C5 I0OL Port 6 Output Data Word 0 14 224

C5 I0L Port 6 Output Data Word 1 15 240

C6I0L Port 7 Output Data Word O 16 256

C6I0L Port 7 Output Data Word 1 17 272

C7 0L Port 8 Output Data Word O 18 288

C7I10L Port 8 Output Data Word 1 19 304 _
COIOL Port 1 Output Data Word 0- 16WD Enabled 20 320 R
COIOL Port 1 Output Data Word 15 - 16WD Enabled 35 560
Imimimimimimimimie el im e m e e m dm e D e D e — Future proofing - RFID or otherunplanned devices
C7I0L Port 8 Output Data Word 0- 16WD Enabled 132 2112

C7I0L Port 8 Output Data Word 15 - 16WD Enabled 147 2352

Figure 3.11 — Output data map, overview
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®  Output data map, word 0

Honda TBEN-LH-8I0OL

Honda TBEN-LH-810L Output Word 0 - 7_APR_2018

"TUNRCK

Data from RSL/Robot to TBEN Word 0.0to .15
Description RSLogix Index Fanuc Starting bit
10L Channel Disable and COto C3 DXP Output Bits 0 0 } 10Link channel disable, 24V DXP output control
Disable COIOL Port 1] 0 0
Disable C110L Port 2| 1 1
Disable C2 |0L Port 3 2 2 isabl d heirred di .
Disable C3 IOL Port 4 3 3 Dlsar e unuse I0LPorts sotheirred diagnostic
- LED isoff. Disabled |OLPorts can be usedas
Disable C4 |0L Port 5| 4 4 .
standard 24V digital inputs..
Disable C5 0L Port 6 5 5
Disable C6 10L Port 7| 5] 6
Disable C7 I0L Port 8| 7 7
Enable CO DXP Output| 8 8 M12 x 1 /O Port
Enable C1 DXP Output 9 9
SaEd Enable DXP 24V outputsavailableonCOto C3 £
Enable C2 DXP Output 10 10 1 01
Enable C3 DXP Output 1 1 2 I AL
Activate CO DXP Output 12 12 1 3 3=GND (V1)
Activate C1 DXP Output 13 13 5 : 4=C/QVn)
- Control enabled DXP 24V outputs available onCOto C3 3=ng
Activate C2 DXP Output 14 14
Activate C3 DXP Output 15 15 .G

Figure 3.12 —Output data map, word 0

®  Output data map, word 1

Honda TBEN-LH-8I0L
TUNRCK
Honda TBEN-LH-8IOL Output Word 1-7_APR_2018 B1 BO
0 Q Direct
Data from RSL/Robot to TBEN Word 1.0to .15 0 1 Swap 16
Description RSLogix Index Fanuc Starting bit 1 0 Swap 32
I0L COto C7 Data Mapping 1 16 1 1 Swap All
COIOL Port 1 Mapping BO 0 16 N X
CO10L Port 1 Mapping B1 - 00=Direct, 01=Swap 16, 01=Swap 32, 11=5wap All 1 17 } 1OLink Port 1 Map Bits
C1I10L Port 2 Mapping BO 2 18 :
C1I0L Port 2 Mapping B1 - 00=Direct, 01=Swap 16, 01=Swap 32, 11=Swap All 3 19 )
- 00 direct A The process data are not swapped.
C210L Port 3 Mapping BO 4 20 : (0x0123 3567 B9AB CDEF)
C2 0L Port 3 Mapping B1 - 00=Direct, 01=Swap 16, 01=Swap 32, 11=Swap All 5 21 I swap 16 bit The bytes are swapped per word,
C310L Port 4 Mapping BO 6 22 : (0x2301 6745 ABBY EFCD)
C3|0L Port 4 Mapping B1 - 00=Direct, 01=Swap 16, 01=Swap 32, 11=Swap All 7 23 o swap 32 bit The bytes are swapped per double word)
C410L Port 5 Mapping BO 8 24 : (0x 6745 2301 EFCD AB89)
C410L Port 5 Mapping B1 - 00=Direct, 01=Swap 16, 01=Swap 32, 11=Swap All 9 25 N swap all All bytes are swapped.
C510L Port 6 Mapping BO 10 26 : (0<EFCD AB89 6745 2301)
C510L Port 6 Mapping B1 - 00=Direct, 01=Swap 16, 01=Swap 32, 11=Swap All 11 27
C610L Port 7 Mapping BO 12 28
C610L Port 7 Mapping B1 - 00=Direct, 01=Swap 16, 01=Swap 32, 11=Swap All 13 29
C710L Port 8 Mapping BO 14 30 . A
C710L Port 8 Mapping B1 - 00=Direct, 01=Swap 16, 01=Swap 32, 11=Swap All 15 a1 } |OLink Port 8 Map Bits

Figure 3.13 — Output data map, word 1
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m  Output data map, word 2

Honda TBEN-LH-8I0L

Honda TBEN-LH-810L Output Word 2 - 7_APR_2018

TUURC K

Data from RSL/Robot to TBEN Word 2.0to .15
Description RSLogix Index Fanuc Starting bit Vauxl Control
VAux 1 and VAux 2 Control 2 32
Turn off VAUX1_Pinl CO_ ChO 1_ 0 32 B 2 o oEm
Turn off VAUX1_Pinl_C1_Ch2 3_ 1 33 ;3 i28awn
Turn off VAUX1_Pin1_C2_ Ch4 5_ 2 34 o e
Turn off VAUX1 Pinl C3_ Ch6 7_ 3 35 L
Turn off VAUX1 Pinl_C4_Ch8 4 36 M2 110 Port
Turn off VAUX1 Pinl_C5_ Ch10 5 37 < _
- 2 N L
Turn off VAUX1 Pinl_C6_ Ch12 6 38 . Z 3 b
N 4=0/Q (V1)

Turn off VAUX1 Pinl_C7_ Ch14 7 39 B 1-gam,
reserved 8 40 cacr
reserved 9 41
reserved 10 42
reserved 11 43 Vaux2 Control
Turn off VAUX2_Pin2_C4__Ch9_ 12 44 5 1=Vau] (V1)
Turn off VAUX2_Pin2_C5_ Ch1l 13 45 2=Vau2 (V2)

— L2 — 1{opo)3 3=GND (V1)
Turn off VAUX2_Pin2_C6__Ch13_ 14 46 o 4=C/Q (V1)
Turn off VAUX2_Pin2_C7__Ch15_ 15 a7 5 4 5=GND (v2)

Figure 3.14 — Output data map, word 2

®  Output data map, word 3

Honda TBEN-LH-8I0L

Honda TBEN-LH-8I0L Output Word 3 - 11_APR_2018

Data from RSL/Robot to TBEN Word 3.0t0 .15 I0Link Output Data
Description RSLogix Index Fanuc Starting bit
10L 16 Data Ward Enable 3 48
€0 16 Word Transfer 0 48 €0 16 Word Transfer =0 [+-Honda_TBEN_LH_8I0L:0.Data[4] COI0L Port 1 Output Data Word 0
C1 16 Word Transfer 1 49 [+-Honda_TBEN_LH_810L:0.Datal5] CO10L Port 1 Output Data word 1
C2 16 Word Transfer 2 50
€3 16 Word Transfer 3 51 |OLink Output Data
C4 16 Word Transfer 4 52 e ——
C5 16 Word Transfer 5 53 | +-Honda_TBEN_LH_810L:0.Data[20] \cu 10L Port 1 Dutput Data ‘Word 0
C6 16 Word Transfer 6 54 CO0 16 Word Transfer =1 AR RS A R R A R R R R R R SR S S S S R SR R R R R SRR RN R R R RN NSRS RS R E
C7 16 Word Transfer 7 55 ] +‘Honda_TBEN_LH_8I0L:0.Data[35] C0 Out Word 15
reserved 8 56
reserved 9 57
reserved 10 58 10Link Input Data
reserved 11 59
reserved 12 60
reserved 13 61 C0 16 Word Transfer = Oor 1 + Honda_TBEN_LH_8I0L:1.Data[2] COI0L Port 1 Input Data word 0
reserved 14 62 +-Honda_TBEN_LH_810L:|.Data[3] COI0L Port 1 Input Data Word 1
reserved 15 63

10Link Input Data

[+-Honda_TBEN_LH_8IOL:1.Data{18] |CO 0L Part 1 Input Dataword 0
C016 Word Transfer=0or1 H-Honda_TBEN_LH_810L:I.Data[33] ||:u In'ward 15
Figure 3.15 — Output data map, word 3
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3.3 Application Requirements

Honda TBEN-LH-8I0L

Application Requirements
* |0Link Master optimized for use with Omron, RSL5000 and Fanuc Robot
* Default Network Settings
* [P Address: 192.168.0.XXX
¢ Subnet: 255.255.252.0
* Reduced Data Footprint
+ 18 words input, 20 words output for simple IOL device integration
* 146 words input, 148 words output for integration of 32 byte IOL devices
» Station Configuration in process Output Data
+ No configuration via web-server required
* Device support including:
¢ 10 Link TBIL standard 24V device expansion
¢ |0 Link Valve Bank integration (Class B Power)
¢ |0 Link Stack Light
« |0 Link RFID
¢ Standard 24V inputs on unused IOL Ports
« Standard 24V In/Out DXP control on CO to C3
* Quick Connect and non-Quick Connect supported

Figure 3.16 —-TBEN-LH-8IOL application requirements

Honda TBEN-LH-8I0L

Integration with RSL5000 using Generic Ethernet Connection
- Connection information included in catalog file

Contraller Crganizer

(=131 Controller Honda_TBEN_L4_SIOL_Sample_MAP1

[ controller Tags Gengal | Connecton | Hedulelnfa |
#+(7 controller Fault Handlsr T ETHERNET-MODULE Geneic Ethemet Module
[ Powes-Up Handler
vendor  AllenBradiey
=50 Tasks
Parent EIP
- ManTsck Cannection Parameters
558 MainPragram Nare: Honda_TBEN_L4_BICL
Program Tags X
B v ot Deseription = ‘
7 Unscheduled Programs { Phases Pt
151 Motion Groups Jid | Dutput
.0 Ungrouped Axes
[ Add-Gn Instructions Comm Format: |Dats - [T =l
=51 Data Types Address {HostHame—————————————
Ly, User-Defined @ IPAdess | 192,180 . 1 .1
7 Lyl Strings
Cj, Add-on-Defred € Host Name: |—
L, Predefined
g, Moduls-Defined

5 g{f?ﬁ;ww Status: Offine [ ok | cenee |
£1- 9 Backplane, 1789-A17/A Vrtual Chassis
-0 [1] 1789160 Handa_TBEN_L4_BL0L_Sample_MAFL
E- B [2]Ethertiet/TP EIP
=& Ethernet
- ] ETHERMET-MODULE Honds_TBEN_L4_8I0L
[T

Quick Connect Disabled: Use Output Assembly Instance 116, QC Enabled: Use Output Assembly Instance 115

Figure 3.17 — TBEN-LH-8IOL integration into RSLogix5000
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3.4 10-Link Port Setup

3.4.1 Open Web Server

» Enter IP address of the deice into Web browser

TBEN-LH-8IOL

Event Log
Ethemet Statistics
Links

I0-LINK PORT 1
IO-LINK PORT 2
IO-LINK PORT 3
IO-LINK PORT 4
IO-LINK PORT 5
IO-LINK PORT 6
IO-LINK PORT 7
IO-LINK PORT 8
I0-LINK EVENTS
VAUX CONTROL

BASIC

Station Information
Type

Identification Number
Firmware Revision
EBootloader Revisien
EtherNet/IP™ Revision
PROFINET Revision
Modbus TCP Revision
Addressing Mode
PROFINET Station Name
ARGEE Boot Project
ARGEE Project Title

ARGEE Factory Programmed

Network Settings
Ethernet Port 1 setup
Ethernet Port 2 setup
IP Address
Netmask
Default Gateway
MAC Address
LLDP MAC Address 1

LLDP MAC Address 2

EtherNet/IP™ Status
Network topology
DLR State

QuickConnect

PROFINET Status
Network topology

FastStartUp

TBEN-LH-8I10L
100002195
V3.1.8.0
Vv1.0.0.0
V27210
V1.47.0
V2220

PGM DHCP

Running
Honda_TBEN_Map_1_V1_0_16NCW2017_xxx

No

Autonegotiate
Autonegotiate
192.168.1.17
2552552520
0.0.0.0
00:07:46:82:56:07
00:07:46:82:56:08

00:07:46:82:56:09

Linear
Normal

Disabled

Linear

Disabled

Figure 3.18 — Web server
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3.4.2 Administrator access

When someone is logged-in as an administrator, it gains the access to the device IP address setup, the
parameters setup and other control functions. The administrator access is controlled by the password,
which may be changed.
The procedure:

» Enter “password” into LOGIN field

- v
e
™ Station Informaticn X

<« C 1t A Notsecure | 192.168.1.17/infohtml w O
=2 Apps Suggested Sites Imported FromIE & Google Health ﬂ MSMNEC (‘:;3 Merriam-Webster's = TURCKUSA - Capac B Google News »
|
TURCK.COM  For comments or questions, please email TURCK Support '“ncx
TBEN-LH-8IOL LOGIN[wwwee |

Figure 3.19 — Administrator login

ﬂ .

If you forget the password, reset the device to the factory defaults (900). Before the reset takes
place, save all IOL current setup, as it will be deleted and set to the factory defaults. After the
reset, the first thing to do is to assign an IP address to the device.

3.4.3 Basic Parameter Setup

» Activate DXP outputs 1.3.5 and 7 by entering “yes” in the drop down selection dialog
» If DXP output short condition needs to be confirmed by the PLC, enter “yes” in the drop down
selection dialog

TURCK.COM For comments or questions, please email TURCK Support '“ne“
TBEN-LH-8IOL LOGOUT [ADMIN@192.168.1.50]

STATION > Basic - Parameters
Station Information
Siation Diagnostics DXP 1 - Manual reset after overcurr.
Event Log
Ethemet Statistics
Links DXP 3 - Manual reset after overcurr

DXP 1 - Activate output

Station Configuration DXP 3 - Activate output

Network Configuration
BEEP Network Configuration
Change Admin Password DXP & - Activate output

DXP 5 - Manual reset after overcurr

BASIC E DXP 7 - Manual reset after overcurr.
Parameters
Inputs
Qutpuis Submit Reset Refresh

DXP 7 - Activate output

Figure 3.20— Basic parameter setup
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3.4.4

Refer to the TBEN-Lx...-8IOL User Manual for the description of the 10-Link master’s features and setup.
The setup made by the Web server is saved in the device permanent memory. If the device is reset to the

IOL Master Default Setup

factory default values, the custom setup will be lost.

TBEN-LH-8IOL

STATION

Station Information
Station Diagnostics
Event Log

Operation mode

LOGOUT [ADMIN@192.168.1.50]

Data storage mode deactivated, clear ¥
Ethemnet Statistics
Links Cycle time
Station Configuration FimrsEn automatic ¥
Network Configuration

Activate Quick Start-Up

BEEP Network Configuration
Change Admin Password

I0-LINK PORT 1

Device parametrization via GSD

Process input data invalid

EEIE :
=
s
£

g
o)
s

diagnostic generated v

IO-LINK PORT 4

Deactivate diagnostics | notifications and wamings ¥ |
Inputs Input data mapping
Oulputs Qutput data mapping
10-LINK PORT 2 Vender ID o
I0-LINK PORT 3 > [ C—

Figure 3.21 — 10-Link master setup page
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3.4.5 VAUX Control

The Vaux1 and Vaux2 power is controlled by the “VAUX control — Parameters” web page:

Available options are:

B 0=24VDC
B 1 =switchable
B 2 =off"

TBEN-LH-8IOL

STATION
Station Information
Station Diagnostics
Event Log
Ethemnet Statistics
Links

Y

IO-LINK EVENTS >
VAUX CONTROL
Parameters

Outputs

TURCK.COM  For comments or questicns, please email TURCK Support

VAUX control - Parameters

VAUX1 Pin1 CO (Ch0/1)
WVAUX1 Pin1 C1 (Ch2/3)
VAUX1 Pin1 C2 (Ch4/5)
VAUX1 Pin1 C3 (Ch&/T)
VAUX1 Pin1 C4 (Ch8)

VAUX2 Pin2 C4 (Ch9)

WAUX1 Pint C5 (Ch10)
VAUX2 Pin2 C5 (Ch11)
VAUX1 Pin1 C6 (Ch12)
VAUX2 Pin2 C6 (Ch13)
WAUX1 Pint C7 (Ch14)

VAUX2 Pin2 CT (Ch15)

Refresh

"TWUNIRCEK

switchable

switchable

switchable

switchable

switchable

switchable

switchable

switchable

switchable

switchable

switchable

switchable

Revision V3.3.0.0

Turck Inc. | 3000 Campus Drive, Minneapolis, MN 55441 | T +1 800 544 7769 | F +1 763 553 0708 | www.turck.com

Figure 3.22 —-VAUX control page
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4 Configure TBEN-LH-8IOL with Rockwell PLC

The configuration of the TBEN-LH with the Logix5000 controllers, using RSLogix5000 / Studio5000
programming environment may be done using:

B EDSfile

B Generic device profile

4.1 TBEN-LH-8IOL Configuration using EDS files

4.1.1 Install EDS file

The EDS file is the Electronic Data Sheet or the device configuration file, described in the
“Volume 1, Common Industrial Protocol (CIP), Edition 3.22, by ODVA”.
The procedure:
» Download TBEN-LH-8IOL_R2.7.EDS file from the TURCK web site
» Inthe RSLogix5000 menu bar, expand the Tools drop down menu and click on the EDS
hardware Installation Tool

3 Logix Designer - CLX72v30 [1756-L72 30.11]
File Edit View 5Search Logic Communications Window Help
BEd & Ls s )
Security »
Offline 0. = RUN 4| g Documentation Languages...
No Forces ». ™ oK [
— a I Energy Storage Import » Eby A Alrm
=110 — Export 5
Redundancy m sepo
+f EDS Hardware Installation Tool - l—,_rE
) Controller Organizer Muotion 3
=] unlmllerCLX?va Plug-In Manager...

Figure 4.1 — Tools menu

» In the Rockwell Automation’s EDS Wizard dialog, click at the Register and EDS file(s) and Next
» Follow the dialog to complete device registration

Rockwell Automation’s EDS Wizard ﬁ

Opticns &
What task do you want to complete? ]

* Register an EDS file(s).
This option will add a device(s) to our database

" Unregister a device.
@ This option will remove a device that has been registered by an EDS file from
our database.

(" Create an EDS file.
This option creates a new EDS file that allows our software to recognize your
device.

g C

Figure 4.2 — Register an EDS file(s)
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4.1.2 Create a new module

» In the Controller Organizer, right-click on Ethernet to access a drop-down menu.

» Click New Module... to open the “Select Module Type” dialog page

e, Logical Model
=3 1/0 Configuration
=83 1756 Backplane, 1756-A7
0 [0] 1756-L72 CLX72v30
B [1]1756-EN2TR EIP_Bridge

Ulg...
Import Module...

Discover Modules...

Figure 4.3 — Add new module

> Enter the device name in the search area
» Highlight the device from the list and click Create.

Catalog | Modue Discovery | Favortes |
TENLH | Clear Filirs |
Module Type Category Fiters ™ Module Type Wendor Filters i
¥ Analog ij ¥ Advanced Energy Industries, Inc. ij
¥ CIF Mation Converter ¥ Advanced Micro Cortrols Inc. (AMCI)
¥ Communication ¥ BALLUFF
¥ Communications + | ¥ Cognex Corporation -
L Rl
Catalog Mumber Description Vendaor Category
100001445 TBEN-LH-16DIP TURCK Communications Ada
100002135 TBEN-LH-BI0L TURCK Communications Ada
e —— E
2 of 680 Module Types Found
Close on Create Create  Cloese | | Help |

Figure 4.4 — Select Module Type dialog page
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4.1.3 Configure TBEN-LH-8IOL using default connection

»  Fillin the Name, Description and Ethernet Address of the device

2| Module Properties: EIP (100002195 2.007)

General |Ccr1nection I Module Info I Intemet Protocol I Port Corfiguration

Type:
Vendor:

Parent:

Name:

Description:

100002195 TBEN-LH-BIOL
TURCK
EIP

TBEN_LH_8IOL_Conn1

Id 100002135
FW V3180
EIP V27210

Project
Honda_TBEN_Map_1_V1_0_16NOV2017 oo

Module Definition

Ethemet Address

(@) Private Network: 152.168.1.
() IP Address:

(7 Host Name:

Revision: 2.007

Electronic Keying:  Compatible Module

Connections: AB TBEN-LH-BIOL
Status: Offline

[

OK ] [ Cancel ] Apply

Figure 4.5 -New Module setup

» Click “Change...” to open the “Module Definition” page, Figure 4.6
» Use default connection “AB TBEN-LH-8IOL” ; select INT data format from the drop down menu,

per Figure 4.6
Click OK to return to previous dialog page
Click “Apply” and “OK”

Y VYV

» Follow the dialog to save configuration, download and go on-line.

7| Module Definition*

Revision:

Electronic Keying:

Connections:

007 [

[Cornpatible Module

Name

Size

Tag Suffic

AB TBEN-LH-8IOL, QC-ON

AB TBEN-LH-8IOL, QC-OFF
Omron TBEN-LH-8IOL

Omron TBEN-LH-BI0L, QC-ON
Omron TBEN-LH-8IOL, QC-OFF

AB TBEN-LH-8I0L Input: 146

Output: 148

TBEN_LH_8IoL:1

- 1

TBEN_LH_BIOL:01

SINT

DINT
REAL

[ ok ][ cancel

| [ Hep

Figure 4.6 — Select connection and data format
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4.1.4 Configure TBEN-LH-8IOL_QC_ON Connection

When the device is configured using a “TBEN-LH-8I0L_QC_ON" connection, the device is switched to the
QuickConnect (QC) mode. The device is “Ready for Connection” at 100msec time after the device power

cycle. The actual connection time depends on a controller setup and system architecture.
The QC_ON connection is configured as follows:

» Create a new module as described in the section 4.1.2
» Fillin the Name, Description and Ethernet Address of the device at New Module dialog page

El Mew Module

General® |Connection Module Info | Intemet Protocol I Port Configuration
Type: 100002195 TBEN-LH-8IOL
Vendor: TURCK
Parent: EIP
Mame: TBEN_LH_8I0L_Conn2 Ethemet Address
Desciiption: Erable OC _) Private Network: 152.168.1.
@) IP Address: 192 . 168 . 1 18
) Host Mame:
Module Definition
Revision: 2.007
Electronic Keying:  Compatible Module
Connections: AB TBEN-LH-8I0L
Change ...
Status: Creating [ QK ] I Cancel I I Help

Figure 4.7 — New Module configuration

» Click “Change...” to open the “Module Definition” page
» Use “TBEN-LH-8I0OL_QC_ON” connection from the Connection Name” drop down list and select
INT data format at the Size drop down list, per Figure 4.8

Y V V

| Module Definition*

Revision: 2 - 007

-

Click OK to return to the previous dialog page
Click “Apply” and “OK at the New Module dialog page
Follow the dialog to save configuration, download program and go on-line.

Blectronic Keying: ICompatible Module

Connections:
MName Size Tag Suffix
Input: 146 TBEN_LH_8I0L_Conn2:1
AB TBEM-LH-BIOL, QC-ON |+ INT 1
Output: 148 TBEN_LH_8I0L_Conn2:01
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When QuickConnect is enabled, the device sets P1 port (ETH1) and P2 port (ETH2) as follows:

B Fixed speed at 100Mb

Forced duplex at Full-duplex

The TBEN-LH-8IOL QuickConnect operational time:

P1 port set as MDI (strait-through connection)
P2 port set as MDIX (cross-over connection)

Auto-Negotiate and Auto-MDX are disabled

B Ready-to-connect time = 100ms (time measured from the device power-up to the first ARP)

B CIP connection time < 10ms

ﬂ NOTE

The incoming Ethernet cable is always connected to P1 port. P2 port is used for daisy-chaining
next node if required. All daisy-chained nodes have to be QC enabled, and have unique IP
address in the system. The QC enabled device does not perform duplicate address check.

Verify setup using the web server:

& C Y @ Notsecure | 192.168.1.18/info.html

~

b=

| == Apps m Suggested Sites
| TURCK.COM For comments or questions, please email TURCK Support

TBEN-LH-8IOL

STATION
BASIC
IO-LINK PORT 1

Station Information

Station Information
10-LINK PORT 2 > Type

10-LINK PORT 3 Identification Number
10-LINK PORT 4

I0-LINK PORT 5

IO-LINK PORT 6

Firmware Revision

Bootloader Revision

EtherNet/IP™ Revision

I0-LINK PORT 7

Network Settings
Ethemet Port 1 setup

Ethemet Port 2 setup

IP Address.

Netmask

EtherNet/IP™ Status
Metwork topology

DLR State

QuickConnect

Imported From[E & Google Health [] MSNBC

'TEII Merriam-Webster's

TBEN-LH-810L
100002195
V3180
V1.00.0

V27210

100BT-FD
100BT-FD
192.168.1.18

2552652520

Linear
Nermal

Enabled

Figure 4.9 - TBEN QC enabled view
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4.1.5 Configure TBEN-LH-8IOL_QC_OFF Connection

The “TBEN-LH-8I0L_QC_OFF” connection disables QC mode and restores the device Ethernet ports to:

B Autonegotiate
B Auto-MDIX

» Follow the steps described in the section 4.1.2 to create a new module
» Fillin the Name, Description and Ethernet Address of the device at the New Module dialog page

5| New Module @
General” | Connection | Module Info I Intemet Protocol | Port Configuration
Type: 100002195 TBEN-LH-8IOL
Vendor: TURCK
Parent: EIP
Name: TBEN_LH_8IOL_Conn3 Ethemet Address
Description: Disable OC () Private Network: 152.168.1.
@ IP Address: 192 . 168 . 1 19
() Host Name:
Module Definition
Revision: 2.007
Electronic Keying: Compatible Module
Connections: AB TBEN-LH-BIOL
Status: Creating [ 0K ] [ Cancel ] [ Help

Figure 4.10 — New Module configuration

» Use “TBEN-LH-8I0OL_QC_OFF” connection from the Connection Name” drop down list and
select INT data format at the Size drop down list, per Figure 4.11

Y V V

5| Module Definition*

Revision: 007 =

Click OK to return to the previous dialog page
Click “Apply” and “OK at the New Module dialog page
Follow the dialog to save configuration, download program and go on-line.

Electronic Keying: [Compatible Module

=l

Connections:
Name Size Tag Suffix
Input: 146 INT TBEN_LH_8I0L_Conn3:1
AB TBEN-LH-BIOL, QC-0OFF - 1
Cutput: 148 TBEN_LH_8IOL_Conn3:01

-

Figure 4.11 — QC_OFF Connection setup
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4.2 TBEN-LH-8IOL configuration using generic device profile

4.2.1 Generic device configuration

The procedure:

» In the Controller Organizer, right-click on Ethernet to display a drop-down menu.

» Click New Module to open the configuration page “Select Module Type”
» Enter “Generic” in the search area, highlight the Generic Ethernet Module and click Create

[
Select Module Type

ETHERNET-BRIDGE Generic EtherNet/IP CIP Bridge
ETHERNET-MODULE Generic Fthemet Module
ETHERNET-SAFETY-5T... Generic EtherMet/IP Safety and Standard Module

Catalog | Module Discovery I Favcntesl
Generic Clear Filters Hide Filters 2
Module Type Category Fiters ol Module Type Vendor Fiters ol
Analog [l Advanced Energy Industries, Inc. [
CIP Motion Converter Advanced Micro Controls Inc. (AMCI)
Communication BALLUFF
Communications Cognex Corporation
Communications Adapter - Dizlight -
Catalog Mumber Description Vendor Category

Rockwell Autom...  Communication
Rockwell Autom Communication
Roclowell Autom...  Safety,Cther

< | 1

| r

3 of £30 Medule Types Found
[¥] Clese on Create [ Create ] [ Close ] [ Help ]

YV V VYV

7| Module Properties Report: EIP (ETHERNET-MODULE 1.001)

Turck Inc. | 3000 Campus Drive, Minneapolis, MN 55441 | T +1 800 544 7769 | F +1 76:

Figure 4.12 — Generic module selection page

Enter the Name, Description and IP Address in the New Module page
Select the Input Data — INT data format in the Comm Format field
Enter the Connection Parameters as seen in the following figure
Click OK and download configuration to the PLC

General | Connection | Module Info |
Type: ETHERMET-MODULE Generic Ethemet Module
Vendor: Roclkowell Automation./Allen-Bradley
Parent: EIP
Connection P, et
Name: TBEN_LH_8IOL_Connd reion TarEmEtEE
Assembly _
Description:  Default configuration - Instance: £
Input: 101 146 = [16+bit)
T Ouput: 110 148 (16it)
Comm Format: | Data - INT Corfiguration: 1 0 =1 @bi)
Address / Host Name
@ |P Address: 152 168 . 1 . 117 Statuz [nput:
(71 Host Name: Statuzs Output:
Status: Cffline [ 0K ] [ Cancel ] Apply Help

Figure 4.13 — TBEN default configuration
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4.2.2 Generic device and QC_ON configuration

The procedure:

» In the Controller Organizer, right-click on Ethernet to display a drop-down menu.
» Click New Module to open the “Select Module Type” configuration page
» Enter “Generic” in the search area, highlight the Generic Ethernet Module and click Create
» Enter the Name, Description and IP Address in the New Module page
» Select the Input Data — INT data format in the Comm Format field
» Enter the Connection Parameters as seen in the following figure
» Click OK and download configuration to the PLC
7| Module Properties Report: EIP (ETHERMET-MODULE 1.001) (23]
General | Connection | Module Info |
Type: ETHERMET-MODULE Generic Ethemet Module
Vendor: Rockwell Automation/Allen-Bradley
Parent: EIP _
Name: TBEN_LH_8I0L_Conn5 Connection Parameters
Azsembly ]
Description:  C_ON configuration - Instance: —
Input: 103 146 = (16hi)
h Output: 115 1428 =] (16mi)
Comm Format: | Dats - INT <
emm Ferm = Corfiguration: 1 0 = (8bit)
Address / Host Name
@ IF Address: 192 . 168 . 1 . 118
) Host Name:
Status: Cffline [ oK l ’ Cancel l Apply Help
Figure 4.14 — TBEN QC-ON configuration
4.2.3 Generic device and QC_OFF configuration
» Repeat procedure as described above
» Enter the Connection Parameters as follows:
5| Module Properties Report: EIP (ETHERNET-MODULE 1.001) =
General |Connedion Module Info|
Type: ETHERMET-MODULE Generic Ethemet Module
Vendor: Roclkwell Automation/Allen-Bradley
Farent: EIP _
Name: TBEN_LH_8I0L_Comn6 Connection Parameters
Assembhy ;
Description:  QC_OFF configuration E Instance:  Size:
Input: 103 146 = (16bit)
~ Output: 116 148 2 (165t
Comm Format: | Data - INT Configuration: 1 0 =1 @bi)
Address / Host Name
@ IP Address: 192 . 163 . 1 . 119
() Host Name:
Status: Cffline [ OK ] [ Cancel ] Apply Help

Figure 4.15 — TBEN QC-OFF configuration
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5 TBEN-LH-8IOL Configuration with OMRON PLC

The configuration of the TBEN-LH device, using the Omron Network Configurator application, is based on
extensive use of the device EDS file. It is assumed that a user is familiar with the Network Configurator
functions.

5.1 Getready environment
5.1.1 Register EDS file
Start Network Configurator and get the device and associated tag sets registered:

» Expand “EDS File” drop-down menu in the Configurator menu bar, click “Install”
» Follow the dialog to install TBEN-LH-8IOL_R2.7.EDS file

.
5B Untitled - Network Configurator

File Edit View MNetwork Device |EDSFile| Tools Option Help
| DS |8 2| 568 nsl. b@ x|
|k | ad| s> |G Cote I
Delete ——
@ Metwork, Canfigurator e
Bn@ EtheiNet/IP Hardware .
: Find...
B Wendor 44 Fin
¢ @-E OMRON Comporation *1 Add to Network
-5, Omron Genenc EIP
= Turck, Inc. [&' Property...
Bﬁ Commurications Adap

Figure 5.1 — Install EDS file menu

Expand TURCK Inc., Communications Adapter, in the Hardware List Window
Right--click at the TBEN-LH-8IOL, select Property pop-up menu
» Verify device identity and EDS file property

A\ A%

TBEN_8IOL r3_20181121 - Network

File Edit View MNetwork Device EDSFile Tools Option TBEN-LH-8I0L Rev 2 Property
LI EIE RN (=
| e agesvox=x|d

= | () EtherNet/IP_1 TBEN-LH-8I0L View
@ Metwark Configuratar i
=-E§] EtherNet/IP Hardware
| E,.. ‘endar = Description : TBEN-LH-BIOL

@) OMRON Corporation 1921681 5 Create Date :  09-13-2016 10:03:31

L@ Omron Generic EIP - 1B

E-{8), Turck. Inc. Etw-EIP21 Modfy Date :  04-262018 10:03:31

Bﬁ Communications Adapter D—u!—- Revision - 27

BL20-PG-EMNA2

FEMZ20-4D1P-4D<P
FENZ20-4100L Vendor : TURCK
TBEM-L4-PLC-10
TEBEN-LH-1EDIP

Device Type :  Communications Adapter

TEEN-LH-EI0L Product Code : 20010
9-- DeviceType o
ﬁ Cammurications Adapter Revision : 20
-, Generic Device Catalog 100002195

Figure 5.2 — TBEN-LH-8IOL device property page
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5.1.2 Add device to the project

» Add Omron CJ1W-EIP21 Communication Adapter from the Hardware List Window, drag and

drop into the new EtherNet/IP network
» Select TURCK TBEN-LH-8IOL Communication Adapter from the Hardware List Window, drag

and drop into the new EtherNet/IP network

,
s v 0

File Edit View MNetwork Device EDSFile Toels Option Help
|DEE| 28| &liadkew ¢ & o x|
|keladlesV| B % 2 &| Q&% 8
x {1 EtherMet/IP 1
a Metwork, Configuratar
EI@ EtherNet/IP Hardware

=) Wendor =

E| OMROM Corporation 1" 3331 ]

192.168.1.5 192.168.250.1

o i Commuricalions Adaper CIWEIPZI  TBEN-LHBIOL
| o Generic Device
G1-{@ Omron Generic EIP D—-l |
E-fa Turck, Ine.

E-oa Communications Adapter

» Right-Click at TBEN to open pop-up window and click Change Node Address
» Assign the device IP address

() EtherMet/TP 1

E _
= Parameter »
S

E.J912‘;-\1EEBIIF1',‘251 2 Monitor..,

= J‘ Reset —

Maintenance Information...

Register to other Device »
External Data »
£ Cut
Copy
> Delete

Change Mode Address...

Change Device Comment...

Figure 5.4 — Change Node Address
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5.1.3 Register tag sets

» Create the input tag set, TBEN_LH_8IOL_lIn, starting at offset DO, length 292 bytes

Edit Device Parameters : 192.168.1.5 CHW-EIP21 ==

Tog 5o
In - Consume | Out - Produce

Name Crver .. Size Bit D

¥E TBEN_LH_BIOL In 292Byte Auto
W 000000 292Byte

Figure 5.5 — Input data tag

» Create the output tag set, TBEN_LH_8IOL_Out, starting at offset D400, length 296 bytes

Edit Device Parameters : 192.168.1.5 CIIW-EIP21 =

Teg S

Out - Produce

In - Consume

Name Ower ... Size Bit ID
5| TBEN_LH_8I0L_Out 296Byte Auto
W DO0500 Enable 296Byte

Figure 5.6 — Output data tag

5.1.4 The device connection types

The device supports multiple connection types. Those named “Omron” are used for configuration with

Omron PLCs:
Assembly Instance
Connection Name Input Qutput Configuration
Instance No |Data size Instance No.|data size Instance No.Data size

AB TBEM-LH-BIOL 101 146 110 148 1 0
AB TBEN-LH-8I0L, QC-ON 101 146 115 148 1 0
AB TBEM-LH-BIOL, QC-OFF 101 146 116 148 1 0
Omron TBEM-LH-BI0L 103 146 110 148 1 0
Omron TBEN-LH-810L, QC-0ON 103 146 115 148 1 0
Omron TBEN-LH-8I0L, QC-OFF 103 146 116 148 1 0

Table 5.7 — Connection types

Explanation of terms:

®  Omron Connection used by Omron PLC

®  TBEN-LH-8IOL Default connection

H QC-ON Connection enables QuickConnect feature

B  QC-OFF Connection disables QuickConnect feature
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5.2 Configure TBEN-LH-8IOL

5.2.1 Configure TBEN-LH-8IOL using default connection

YVVVVYVYVYVYYVVYY

Right click at the controller to open pop-up menu
Highlight Parameter in the menu and select Edit

Drag and drop TBEN-LH-8IOL from the Unregister Device List into Register Device List

Click at New... button to open the Edit Connection configuration page
Click at the Connection I/O Type selection field , drop down arrow
Select Omron TBEN-LH-8IOL connection

The Target Device info is auto-populated based on the EDS file definition

Enter the Originator Device 10 tag sets and connection type as follows
Register device

192.168.1.17 TBEN-LH-BIOL Edit Connection

It will add a connection configuration to originator device.
Fleaze configure the Tag Set each of originator device and target device.

Connection 1/0 Type: [ Omron TBEN-LH-8I0L -
Onginator Device Target Device
Mode &ddresz: 192.168.1.5 Mode Addresz ;. 132168.1.17
Comment . CITW-EIP21 Comment:  TBEM-LH-2I0L
Input Tag Set Edit Tag Sets Output Tag Set :
| TBEM_LH_8I0L_In-[232Byte] | #* Input_103 - [232Bte]
Eunn_?yc:gzr? [F'u:uint to Point connection v]
Output Tag Set Edit Tag Sets Ihput Tag Set :
[TBEN_LH_BIDL_D ut - [296B pte] v] ":# Output_110 - [296B yte]
I:Dnn.?dimj' [F'u:uint to Paoint connection v]
ype
Hide Detail
Detail Parameter
Packet Interval [H PI] . a0.0 s [ 0.5 - 10000.0 ms ]
Timeout Value ; [F'acket Interval [FP1] « 4 E?SEE;EIDEHS‘ZF;%
Connection Struchure
.@ 192.168.1.5 CJ1w-EIP21 =
Reqist ] [ Close

Figure 5.8 — Edit Connection configuration page
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5.2.2 Configure TBEN-LH-8IOL using QC-ON connection

The QC-ON connection enables the QuickConnect feature in the device.
The procedure:

» Right click at the controller to open pop-up menu
» Highlight Parameter in the menu and select Edit
» Drag and drop TBEN-LH-8IOL from the Unregister Device List into Register Device List
» Click at New... button to open the Edit Connection configuration page
» Click at the Connection I/0O Type selection field , drop down arrow
»  Select Omron TBEN-LH-8IOL, QC-ON connection
» The Target Device info is auto-populated based on the EDS file definition
» Enter the Originator Device 10 tag sets and connection type as follows
» Register device
192.168.1.17 TBEN-LH-8IOL Edit Connecticn L&

It will add a connection configuration to anginator device.
Fleaze configure the Tag Set each of onginator device and target device.

Connection /0 Type ;| Ormron TBEM-LH-B10L, QC-OM -
Originator Device Target Device
Mode Addresz: 19216815 Mode Addresz:  192168.1.17
Comment :  CITW-EIP21 Comment :  TBEM-LH-8I0L
Input Tag Set Edit Tag Sets Output Tag Set :
| TBEN_LH_BIOL_In- [292Byte]  + | #ﬁ Input_103 - [292Byte] -
I:DmTE;t::gr? [F'oint to Point connection v]
Output Tag Set : Edit Tag Sets Ihput Tag Set :
[TBEN_LH_EHDL_Dut - [296E yte] v] "# DOutput_115 - [296B pte] -
ED””?':“W? [F'oint to Point connection ']
ype:

Detail Parameter

FPacket Interval [HPH . 50.0 ms [ 0.5 - 10000.0 ms ]

Cannection Mame :

Timeout Value : [F'au:ket Interval (RPI) = 4 [Passible bo armitl

Connection Structure
.@ 192 168.1.5 CHW-EIP21 =

Regist ] [ Cloze

Figure 5.9 — Register device with QC enabled
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5.2.3 Configure TBEN-LH-8IOL using QC-OFF connection

The QC-OFF connection disables the QuickConnect feature in the device.
The procedure:

» Right click at the controller to open pop-up menu
» Highlight Parameter in the menu and select Edit
» Drag and drop TBEN-LH-8IOL from the Unregister Device List into Register Device List
» Click at New... button to open the Edit Connection configuration page
» Click at the Connection I/0O Type selection field , drop down arrow
» Select Omron TBEN-LH-8I0L, QC-OFF connection
» The Target Device info is auto-populated based on the EDS file definition
» Enter the Originator Device 10 tag sets and connection type as follows
» Register device
192.168.1.17 TBEN-LH-8IOL Edit Connection &J

It will add a connection configuration to anginator device.
Pleaze configure the Tag Set each of ariginator device and target device.

Connection 120 Type: | Omron TEEM-LH-210L, QC-OFF -
Originatar D evice Target Device
Mode Addresz: 19216815 Mode Addresz: 192.168.1.17
Comment . CITW-EIP21 Comment:  TBEM-LH-BI0L
Input Tag Set Edit Tag Sets Output Tag Set
|TBEN_LH_GI0L_In-[292Byte]  ~ | #* Input_103 - [292B yte]
Eunn_ln?ggzr? [F'u:uint to Point connection "]
Output Tag Set: Edit Tag Sets Ihput Tag Set :
[TBEN_LH_BIDL_EIut - [296Byte] v] ":# Output_116 - [296Byte]
Ennn_lgcticnr? [F'u:uint to Point connection v]
wpe

Dretail Parameter

Packet Interal [H PI] . a0.0 ms [ 0.5 - 10000.0 mz ]

Connection Mame :

Timeout Walue ; [F'acket Interval [P = 4 [Pazsible ta omitl

Cannectian Structure

& 192.168.1.5 CHW-EIP21 =

R eqist l [ Cloge

Figure 5.10 — Register device with QC disabled
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6 Resources

6.1.1 10-Link master user manuals, data sheets, IODDs

B TBEN-Lx-8IOL
https://pdb2.turck.de/us/DE/products/000000170001d3a7000a003a
https://pdb2.turck.de/us/DE/products/0000001600019e750008003a

B TBEN-S2-4I10L
https://pdb2.turck.de/us/DE/products/0000003100008dc50003003a

6.1.2 10-Link slave devices

B The data sheets, configuration files, user manuals

https://www.turck.us/en/iolink-2577.php

6.1.3 FLC controller

B  ARGEE
https://pdb2.turck.de/us/DE/products/000000370002b2930005003a

B |O-Link IODDs
https://pdb2.turck.de/us/DE/groups/0000000600003a8a00010023
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https://pdb2.turck.de/us/DE/products/000000170001d3a7000a003a
https://pdb2.turck.de/us/DE/products/0000001600019e750008003a
https://pdb2.turck.de/us/DE/products/0000003100008dc50003003a
https://www.turck.us/en/iolink-2577.php
https://pdb2.turck.de/us/DE/products/000000370002b2930005003a
https://pdb2.turck.de/us/DE/groups/0000000600003a8a00010023

TURCK sells its products through Authorized Distributors. These distributors provide our customers
with technical support, service and local stock. TURCK distributors are located nationwide —
Including all major metropolitan marketing areas
For Application Assistance or for the location of your nearest TURCK distributor, call:
1-800-544-7769

Specifications in this manual are subject to change without notice. TURCK also reserves the right to
make modifications and makes no guarantee of the accuracy of the information contained herein.
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